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Export Controls 

Exports of SightLine products are governed by the US Department of Commerce, Export Administration 
Regulations (EAR); classification is ECCN 4A994. The export summary sheet located on the 
support/documentation page of our website outlines customers responsibilities and applicable rules. 
SightLine Applications takes export controls seriously and works to stay compliant with all export rules. 

Copyright and Use Agreement  

© Copyright 2018, SightLine Applications, Inc. All Rights reserved. The SightLine Applications name and 
logo and all related product and service names, design marks and slogans are the trademarks, and 
service marks of SightLine Applications, Inc.  

Before loading, downloading, installing, upgrading or using any Licensed Product of SightLine 

Applications, Inc., users must read and agree to the license terms and conditions outlined in the End 

User License Agreement. 

All data, specifications, and information contained in this publication are based on information that we 

believe is reliable at the time of printing. SightLine Applications, Inc. reserves the right to make changes 

without prior notice. 

Alerts 

The following notifications are used throughout the document to help identify important safety and 
setup information to the user: 

 CAUTION: Alerts to a potential hazard that may result in personal injury, or an unsafe practice 
that causes damage to the equipment if not avoided. 

 

 IMPORTANT: Identifies crucial information that is important to setup and configuration 

procedures. 

 Used to emphasize points or reminds the user of something. Supplementary information that aids in 
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1 Overview 

This document describes how to use various commercial off-the-shelf media players and VMS (Video 
Management System) software to stream video from the RTSP server running on either the 1500-OEM 
or 3000-OEM systems. Most video client examples use VLC. For more complex tasks, FFmpeg/FFplay or 
GStreamer can be used.  

1.1 Associated Documents 

EAN-Startup Guide 1500-OEM: Describes steps for connecting, configuring, and testing the 1500-OEM 
video processing board on the 1500-AB accessory board. 

EAN-Startup Guide 3000-OEM: Describes steps for connecting, configuring, and testing the 3000-OEM 
video processing board on the 3000-IO interface board.  

EAN-Encoding: Outlines SightLine’s encoding capabilities and library support of motion imagery 
standards for streaming video and metadata. Includes a list of known working software and hardware 
decoders. 

EAN-Video Management Software - Reviews third party Video Management Software (VMS) packages 
that connect and receive video from SightLine products. 

Interface Command and Control (IDD): Describes the native communications protocol used by the 
SightLine Applications product line. The IDD is also available as a local download on the Software 
Download page 

EAN-Panel Plus User Guide: Provides descriptions of all the settings in the Panel Plus application. 
(Located in the Panel Plus application in the Help menu.) 

1.2 SightLine Software Requirements 

 IMPORTANT: The Panel Plus software version should match the firmware version running on the 
board. 

1.3 Application Bit Requirements    

The functions described in this EAN require Application Bits (app bits) purchased from SightLine. App 
bits reside on the hardware unit and are enabled with a license file provided by SightLine at initial unit 
purchase or during a license upgrade process. License files use a hardware ID that is applicable to a 
specific hardware serial number. For questions and upgrade support contact SightLine Sales. 

Table 1: Application Bits Requirement Table  

Function  Minimum Software Version Required Application Bit(s) 

1500-OEM RTSP support 2.22.xx IP Encoding.  0x0004 

3000-OEM RTSP support 2.24.xx IP Encoding.  0x0004 

 

 

 

http://sightlineapplications.com/docs/EAN-Startup-Guide-1500-OEM.pdf
http://sightlineapplications.com/docs/EAN-Startup-Guide-3000-OEM.pdf
http://sightlineapplications.com/docs/EAN-Encoding.pdf
http://sightlineapplications.com/docs/EAN-Video-Management-Software.pdf
http://sightlineapplications.com/idd/
http://sightlineapplications.com/support/software-downloads/
http://sightlineapplications.com/support/software-downloads/
mailto:sales@sightlineapplications.com
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1.4 Third Party Software  

VLC media player: Used to display video.  

FFplay Media Client: Included in the Panel Plus application folder.  

The RTSP server from SightLine Applications is compatible with other RTSP clients including VMS (Video 
Management Systems) compliant with RFC 2326. 

1.5 Feature Overview 

RTSP IP Network Protocols 

• RTP MJPEG • UDP and TCP Packets 

• RTP H.264 • Unicast Streaming 

• RTP MPEG2-TS H.264 + Metadata • Multicast Streaming 

• RTP MPEG2-TS MPEG-4 + Metadata • Multiple Unicast Streaming 

 • TCP Tunneling 

• RTCP 

Streaming Clients 

• 1 camera stream (1500-OEM) 

• 2 camera streams (3000-OEM) 

• 8 simultaneous connections (1500-OEM) 

• 16 simultaneous connections (3000-OEM) 8 sessions for 
Net0, 8 sessions for Net1 

Multiple Display Options On Screen Display (OSD) 

• Picture-In-Picture 

• Side-By-Side  

• Zoom to Track  

• False Color 

• Digital Pan, Tilt, Zoom, and Rotation 

• Text 

• Shapes 

• Customer Logo / Watermark 

 

Authentication Keep Alive 

• Digest Authentication                                                    • RTSP Keep alive timeout is set to 120 seconds 

1.6 Definitions 

SLA Hardware: Any number of OEM hardware products available from SightLine Applications such as the 

1500-OEM and 3000-OEM. 

RTSP Server: SLA hardware will host an RTSP server that will handle client connections and translate 

RTSP requests into actionable video streaming by VideoTrack. 

RTSP Client: Remote software which communicates with the RTSP Server to negotiate the streaming 

video session. 

VideoTrack: The video processing software from SightLine Applications that runs on SLA hardware. 

Panel Plus: The PC user interface from SightLine used for configuring and testing SLA hardware. Its 

intent is to introduce SightLine Command and Control Protocol (FIP) that can be 

implemented in the client’s software. Panel Plus is a stand-in for any other client such as 

an auto-pilot or ground control station that can be used to control the SLA hardware. 

VMS: Video Management System 

https://www.videolan.org/vlc/
https://tools.ietf.org/html/rfc2326
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1.7 RTSP Overview 

RTSP (Real Time Streaming Protocol) allows a media client such as VLC to request streaming video in a 
variety of formats from a server such as the 1500-OEM. The RTSP client and RTSP server negotiate the 
destination port and video format, but actual streaming of video is done by another service 
(VideoTrack on the 1500-OEM and 3000-OEM), typically using the RTP streaming protocol over UDP. 
An introduction to the RTSP protocol can be found on Wikipedia. Detailed and authoritative 
information is available from RFC 2326. 

1.7.1 How it Works 

The SightLine RTSP Server will startup automatically on power up 
of the hardware and will listen for inbound connections on port 
554. Before clients can connect, system administrators use Panel 
Plus to configure the video encoding parameters, such as codec 
(MJPEG, H.264) and other parameters such as quality, frame 
rates, and image size. 

To view the video, operators will use a simple standard URL: rtsp://<<ip address>>, where the IP 
address is the unique address for the SLA-Hardware. The video client will then handle all the 
connection details behind the scenes communicating with the SightLine RTSP server. 

 IMPORTANT: RTSP sessions are not recommended for applications where there is active gimbal 
control because of the additional latency introduced by the RTSP session.    

1.7.2 RTSP Requests and Features  

The RTSP server running on SLA-boards supports sending the video stream in different formats. Consult 
the client software documentation for any specific formatting requirements for the video payload. The 
SightLine Hardware can be configured to deliver video in the following formats for use with RTSP: 

• RTP-H.264: H.264/AVC encoded video stream 

• RTP-MPEG2-TS H.264: H.264 encoded video stream within an MPEG2 Transport Stream 

• RTP-MPEG2-TS MPEG-4: MPEG4 encoded video stream within an MPEG2 Transport Stream 

• RTP-MJPEG: MJPEG (Motion JPEG) video stream  

These types of encoded payloads will need to be selected prior to establishing RTSP sessions with the 
video processing board. Panel Plus is used to select the desired encoded video payload format.  

By default, OEM boards will send out video encoded as H.264 in an elementary stream inside an 
MPEG2 Transport Stream. The client software may already support this format. This is a MISB (Motion 
Industry Standards Board) requirement for UAV video streams. For more information refer to the EAN-
Encoding document or go to the MISB website.  

 SightLine hardware is designed as a live streaming encoder. The RTSP server does not currently 
support a pause option. 

https://en.wikipedia.org/wiki/Real-time_Transport_Protocol
https://tools.ietf.org/html/rfc2326
http://www.gwg.nga.mil/misb/index.html
http://sightlineapplications.com/docs/EAN-Encoding.pdf
http://sightlineapplications.com/docs/EAN-Encoding.pdf
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1.8 Before Starting 

Use the EAN-Startup Guide 1500-OEM  or the EAN-Startup Guide 3000-OEM to setup the SLA hardware 
and confirm that video and Ethernet communications are functioning. For the purposes of examples 
shown in this EAN, the following IP addresses are used: 

PC: 192.168.0.23 1500-OEM: 192.168.0.115 3000-OEM: 192.168.0.24 

2 Configuring 1500-OEM for RTSP Sessions 

This section describes how to set up the 1500-OEM to send the selected RTP payload for a RTSP 
session through VLC media player client. The following steps will reference the Panel Plus software.  

1. Connect to the board using the Panel Plus application.    

2. Go to the Compression tab. 

3. In the RTP section select one of the four encoded payload options. In this example, RTP H264 is 
selected. Click Send. 

 

 It is not required to set an IP address or Port for a remote client. They will be set when the RTSP 
client connects.  

If streaming to Panel Plus, encoding, transport and general performance can be verified using the 
onscreen statistics. 

 

 To save the settings to the parameter file, from the main menu » Parameters » Save to Board. 

4. Close the Panel Plus application. Click No in the dialog window. 

 

5. Load the RTSP client and enter the IP address of the 1500-OEM board. In this example, VLC media 
player is the RTSP client requesting a session. 

 

http://sightlineapplications.com/docs/EAN-Startup-Guide-1500-OEM.pdf
http://sightlineapplications.com/docs/EAN-Startup-Guide-3000-OEM.pdf
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6. Launch the VLC media player and using the main menu, select Media\Open Network Stream. In the 
URL field use the following syntax:  

rtsp://<ip-address-of-SLA-board>  

 

7. Click Play to begin the connection.  

8. The VLC media client will negotiate with the 1500-OEM RTSP server to establish a session.  

9. If authentication is enabled VLC will pop up the authentication dialog box. Enter the login and 
password in the login prompt as configured in the RTSP server. 

 

10. To avoid the login prompt, by-pass the username and password directly in the URL by using the 
following syntax: 

rtsp://<login>:<password>@<ip-address> 

Example:  The username is admin. The password is bls_345. The following URL can be used with the 
user name and password to avoid the login prompt:  

rtsp://admin:bls_345@192.168.1.15 

11. If authentication is successful or authentication is disabled, the video will start streaming from the 
RTSP server. If video is not streaming, refer to the Troubleshooting section.  
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3 Configuring 3000-OEM for RTSP Sessions 

This section describes how to set up the 3000-OEM to send the selected RTP payload for a RTSP 
session through VLC media player client.  

The 3000-OEM board can output two network streams. These streams are assigned to logical 
networks: Network 0 and Network 1. RTSP clients can establish sessions on either of these network 
channels. When using Network 1, the 3000-OEM must be configured with Panel Plus.  

1. Open the Panel Plus application and connect to the 3000-OEM board. 

2. Go to the Compression tab.  

3. In the top Output section, select the Output Frame Size for the session. 

4. In the RTP section select one of the two available encoded payload options, and then click Apply. 
The alternate options will be grayed out. In this example, RTP H264 is selected. 

 

 Do not set an IP address or Port for a remote client. Only set these to the host PC if the video 
stream is viewed in Panel Plus 

5. Go to the Multi Camera tab. Using the radio buttons to assign the preferred camera to either 
Network 0 or Network 1. In this example, Camera 0 is assigned to Network 0.  

 When making changes save the parameter file to the board as needed. Main menu » 
Parameters » Save to Board. 

Assign Camera 0 to Network 0

 

6. Load the RTSP client and enter the IP address of the 3000-OEM board. In this example, the board 
has been assigned IP the address of 192.168.0.24. The VLC media player is the RTSP client 
requesting a session. 
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7. Launch the VLC media player and using the main menu, select Media\Open Network Stream. In the 
dialog box provided use the following syntax: 

rtsp://<ip-address-of-SLA-board>/<Network> 

The network designation is either net0 or net1. For example: 

 

 Network designations allow choosing either of the logical outbound networks support by 3000-
OEM. 

8. Another client can stream simultaneously from Network 1 by using the net1 designation. For 
example: 

 

9. Click Play to begin the connection. 

10. The VLC media client will negotiate with the 3000-OEM RTSP server to establish a RTSP session.  

11. If authentication is enabled, VLC will pop up the authentication dialog box. Enter the login and 
password in the login prompt as configured in the RTSP server. 

 

12. To avoid the login prompt, by-pass the username and password directly in the URL by using the 
following syntax: 

rtsp://<login>:<password>@<ip-address>/<Network> 

Example: The user name is admin and password is bls_345. The following URL can be used with the 
user name and password to avoid the login prompt: 

rtsp://admin:bls_345@192.168.1.15/net1 

12. If authentication is successful or if the authentication has been disabled, the video will start 
streaming from RTSP server. If the video is not streaming, refer to the Troubleshooting section. 
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4 Joining Multicast Sessions Through RTSP 

RTSP can join to an existing multicast session if the multicast session is configured through Panel Plus 
for a network.  

To join a multicast session through RTSP: 

1. Open the Panel Plus application and connect to the 1500-OEM or 3000-OEM. See the 1500-OEM 

Startup Guide or the EAN-Startup Guide 3000-OEM for connection instructions 

2. Follow the steps in the previous sections to configure the network and camera. 

3. Go to the Compression tab and click Use Multicast. In the IP Address window enter the multicast 
address and port if it is different than the default multicast address and port shown.  

4. Click Send to begin streaming. The video should start rendering in the Panel Plus display window. 

 

5. Launch the VLC media player. 

6. From the main menu select Media\Open Network Stream. In the URL field use the following syntax: 

rtsp://<ip-address-of-SLA-board>/<Network> 

7. The network designation is either net0 or net1, for example: 

 

The Video should start streaming in the VLC media player. 

 Starting a unicast session (RTSP URL) or joining a multicast session are the same. RTSP URL should 
always use the IP Address of the board and not the multicast address given in Panel Plus. 
Terminating RTSP multicast session will only terminate the RTSP session. The SLA hardware will 
continue to stream to the multicast address. Panel Plus should be used to terminate the multicast 
streaming by either clicking the Stop Streaming button or switching to Unicast session in the 
Compression tab. 

 

 

 

 

 

http://sightlineapplications.com/docs/EAN-Startup-Guide-1500-OEM.pdf
http://sightlineapplications.com/docs/EAN-Startup-Guide-1500-OEM.pdf
http://sightlineapplications.com/docs/EAN-Startup-Guide-3000-OEM.pdf
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5 RTSP Commands 

The RTSP server in the SLA hardware supports the following RTSP methods (commands): OPTIONS, 
DESCRIBE, SETUP, PLAY, GET_PARAMETER, SET_PARAMETER, and TEARDOWN. 

6 RTSP Authentication 

RTSP server supports Digest Authentication mechanism based on RFC 2069. Currently RTSP Server does 
not support Basic Authentication. Digest Authentication applies MD5 hash function to the username 
and password before sending them over the network.  

RTSP Authentication is disabled by default. It can be enabled through a command line argument while 
starting RTSP Server. 

6.1 Procedure Overview 

Step 1:   Create / Modify Password File 

Step 2:   Enable RTSP Authentication 

Step 3:   Copy files to target SLA hardware 

Step 4:   Reboot SLA hardware 

Step 1: Create / Modify Password File 

The password file should be named .htpasswd and have multiple entries corresponding to different 
users. Each entry in the password file should use the following syntax: 

<username>:<realm>:MD5(username, realm, password) 

Example 1:   Assume the following information for Username and Root. 

Username: Root: 

Realm Sla_rtspserver 

Password root 

.htpasswd entry:  root:sla_rtspserver:54a6205c85e92a26699dc2c1184e887d 

The md5 hash can be generated online using http://www.md5.cz/ or http://onlinemd5.com/ .  

 

Figure 1: MD5 Online Hash Generator 

 Onlinemd5 generates in upper case. Convert into lower case before writing into .htpasswd file. 

 

https://en.wikipedia.org/wiki/Digest_access_authentication
https://www.ietf.org/rfc/rfc2069.txt
http://www.md5.cz/
http://onlinemd5.com/
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Example 2:  

Username:  admin  

Password:   bls_345 

Realm:   sla_rtspserver 

MD5 (admin:sla_rtspserver:bls_345):  66b7f77eb8d65ece28a3a36ad2ba8736 

.htpasswd entry:  admin:sla_rtspserver:66b7f77eb8d65ece28a3a36ad2ba8736 

Step 2: Enable RTSP Authentication 

Format to enable authentication: 

<path to rtsp executable>/<rtspMain> -a <path to password file> <realm to use> 

Example: /rtspMain -a /root la_rtspserver 

In the above example:      

• rtspMain  rtsp executable 

• /root/  path where .htpasswd is in the file system 

• sla_rtspserver Realm to be used 

Realm: A string that identifies the username and password. This string should contain the name of the 
host performing the authentication and indicate the collection of users who have access.  

Example: registered_users@gotham.news.com or sla_rtspserver. 

Realm should be specific to the customer or product. Digest authentication uses Realm to group 
usernames and passwords. 

Step 3: Copy Files to Target SLA Hardware 

Use FileZilla, or equivalent utility to copy files to designated SLA hardware. 

1500-OEM destinations: /root/.htpasswd, and /etc/rc.d/rc.local 

3000-OEM destinations: /home/root/.htpasswd, and /home/root/sla3000_init.sh 

The 3000-OEM file system is normally read-only. Before copying to it, use the SLA-3000 Upgrade Utility 
to make the file system writable. From the menu, go to File » Advanced » Make Writable. The file 
system will return to read-only on the next reboot. 

Step 4: Reboot SLA Hardware 

RTSP authentication is now enabled. 
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7 Generating SDP File Using Panel Plus 

1. Open the Panel Plus application and connect to the 3000-OEM / 1500-OEM board.  

2. Go to the Compression tab. 

3. In the CODEC / TRANSPORT section, select one of the four encoded payload options. In this 
example, RTP H264 is selected. 

4. In the Output Properties section, select the Output Frame Size for the session. 

 When input field changes have been detected in the Compression tab the Send button will turn 
red. Click the Send button to send the changes to the board. 

 

5. Click Export SDP File. This will generate an SDP file and will save it to a user designated folder. 

 

 If the configuration is not valid, the following error window opens. 

 

6. Use the generated SDP file in VLC or other players to stream the video. 
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8 Additional Configurations for VLC  

8.1 Improving Latency 

VLC Media player can cause a lag in the video frames being displayed due to internal buffering.  

To reduce the latency in VLC: 

1. Launch the VLC application. 

2. Go to Tools » Preferences » Input / Codecs.  

3. Set Default Caching policy to Lowest latency. 

To reduce the Latency further: 

1. Go to Open Network Stream. 

2. Enable Show more options. 

3. Change the caching amount in the drop down or edit the network caching option.  

 

8.2 Bypass RTP Client Port  

VLC may use same control port for all the instances of the application, which will allow only one VLC 

instance to receive the RTP stream. This behavior can be overridden by bypassing the RTP client port as 

an optional parameter in network streaming.  

To set the RTP client port for network streaming: 

1. In VLC, go to Open Network Stream. 

2. Enable Show more options. 

3. In Edit options, enter client port using the following syntax:  

rtp-client-port=<client_port to be used> 
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8.3 Enabling TCP Transport Mode 

RTSP server supports TCP transport mode for streaming. RTP packets will be sent in the same RTSP 
connection instead of a separate UDP connection. 

 IMPORTANT: Multicast support through RTSP is not available in TCP mode. 

To enable TCP mode in VLC:  

1. In VLC, go to Tools » Preferences » Input/Codecs. 

2. Enable RTP over RTSP (TCP). 

Follow the configuration steps mentioned in previous sections to begin streaming to VLC. 

To switch back to UDP mode: 

1. In VLC, go to Tools » Preferences » Input/Codecs. 

2. Enable HTTP (default) to switch to UDP streaming. 

 

8.4 VLC Media Player with SDP File 

In this method, VLC is a passive receiver of video being streamed by UDP. The SDP file sends the 
properties of the stream to the VLC so it can be properly interpreted. 

This only works if -  

- the video is already streaming,  

- no other process (like Panel Plus) is reading the video, 

- the SDP file accurately describes the stream. 

This section describes how to open the SLA video stream using a SDP (Session Description Protocol) file 
with the VLC media player.  

1. Using Panel Plus software, create a standard RTP output stream. Set the outbound UDP Port to 
5400. Verify that the video can be seen in the Panel Plus display window. 

2. Follow the steps in section 7 to generate an SDP file. 
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3. Close the Panel Plus application, and then click No in the prompt. 

 

4. Start the VLC media player. 

5. Use the main menu to open the file that was saved. 

 

6. Click Play at the bottom of the window. VLC will then display the video stream in the display 
window. 

9 Configuring RTSP Streaming in Media Players 

SightLine supports many of the media players available that utilize RTSP streaming and RTP protocols. 
Procedures to configure RTSP/RTP streaming on other media players and VMS software are similar to 
VLC.  

For both the 1500-OEM and the 3000-OEM, follow the same steps for setting the network 
configuration for testing the RTP output stream. 
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10 Using FFplay with RTSP 

This section describes how to open the SLA video stream via RTSP and using FFplay media player. The 
FFplay executable is included in the Panel Plus installation folder. 

1. Navigate to the SightLine Applications folder on the host PC hard drive.  

2. Open the Panel Plus folder. 

3. In the window address bar type CMD, and then press the Enter key to open a command prompt 
window. 

 

4. In the command window, type the following command: 
FFPLAY rtsp://<enter-ip-address-here>:<port number>   

Example: FFPLAY rtsp://192.168.0.24:554 

The video will be displayed in the FFplay media presentation window. 

10.1 Using FFplay with SDP File 

See the above section on using VLC with an SDP file. The same steps apply.  

1. Select video format. 

2. Create an SDP file. 

3. Start streaming.  

4. Exit Panel Plus as described above.  

5. Assuming the SDP file is called rtp.sdp, launch FFplay by using the command:  

<ffplay rtp.sdp> 

Some versions of ffplay require additional arguments: 

<ffplay -protocol whitelist file,udp,rtp rtp.sdp> 

FFplay should launch a display window with the RTP video stream.  
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11 Streaming RTSP to Panel Plus 

Panel Plus can be configured as an RTSP Client to receive video streams through RTSP protocol from 
SLA-boards. The procedure to configure Panel Plus as an RTSP Client and start streaming through RTSP 
protocol is outlined below. 

1. Configure the cameras and connect to SLA Board through Panel Plus as described in Configuring 

1500-OEM for RTSP Sessions or Configuring 3000-OEM for RTSP Sessions. 

2. In the Compression tab choose the desired RTP Protocol. RTSP protocol mandates transport 

protocol as RTP.  

 

3. Keep other settings in the Compression tab the same for regular streaming. Configuring IP and Port 

is not required for an RTSP streaming session. 

4. Click Stream RTSP URL in the Streaming section. 

 

5. Panel Plus will open a window with available streaming URLs, including RTSP based on current 

configuration in the Compression tab. 

Example 1:  

RTP setting: RTP H.264  

Chosen network: Net0 

IP of board: 192.168.1.157 

Displayed dialog window: 
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Example 2:   

RTP setting: RTP TS-H.264  

Network: Net1 

IP of board: 192.168.1.157  

Displayed dialog window: 

 

 The dialog window also shows a sample RTP URL that can be used with other players like VLC, 
which support RTP streaming. 

6. Click on Start Streaming RTSP.  

If the configuration is correct, Panel Plus will start rendering video through RTSP. If Panel Plus is 

already streaming, the video will be stopped and the RTSP session will start. 

Once the RTSP session is initiated. the Compression tab will show the local host address (127.0.0.1) 
and port number. It will be either 8008 or 8010. This indicates the RTSP session is initiated. 

7. To stop the RTSP session, click on Stream RTSP URL in the Compression tab. If the RTSP is already 

streaming to Panel Plus it will show the Stop Streaming RTSP button. 

 

Click Stop Streaming RTSP to stop the RTSP session in Panel Plus.  

 

 IMPORTANT: This will stop all streaming sessions including any Media player (VLC) RTSP sessions 
from the same board to a different IP than the one running Panel Plus. Stopping through the 
streaming URL button and clicking the Stop Streaming RTSP button is the preferred method. 
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8. Switching to a regular streaming can be done by entering the IP and Port manually in Compression 

tab and clicking the Send button and the Start streaming button. This will restart the streaming 

session without RTSP. 

 IMPORTANT: RTSP streaming has no dependency on from which Network Panel Plus is 
receiving video. RTSP can start streaming from Network1 even though Panel Plus is set to 
receive video from Network 0 in the Multicamera tab. 

 RTSP Streaming through TCP mode is not supported through Panel Plus. 

 RTSP streaming is possible to Panel Plus from the board even if another media player is 
streaming from the same board through RTSP on the same PC. 

12 Streaming Video Over the Internet 

With 2.23 support of RTSP, video can be streamed over the internet. A simple network topology is 
shown in Figure 3. 

Basic setup steps: 

1. Configure the SLA hardware for RTP streaming. 

2. Configure the router to allow port 554 forwarding to the SLA hardware. 

3. Connect to the video client. 

Router

192.168.1.42

192.168.1.181

Router
Remote Video 

Client

140.211.16.67

Ground Station

UAV 001

INTERNET

RTSP PORT 554

 

Figure 2: Simple Network Topology 

 Additional configuration steps may be necessary depending on how the network is setup. 
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13 Configure the SLA Hardware 

 Detailed configuration information is covered in the previous sections. 

1. In the Compression tab of Panel Plus, select one of the RTP streaming modes.  

 

2. Save the parameters to the board, main menu » Parameters » Save to Board. 

3. In the bottom status bar of Panel Plus, note the IP address of the system. This will be used to 
configure the router in the next section. 

 

13.1 Configure the Router 

Configure the router to forward port 554 of your external IP address to port 554 of the SLA hardware. 
The example shown uses a COTS D-Link DIR-601 router. Consult your router documentation on how to 
configure the port forwarding function. 

1. Use a web browser to log on to the router, e.g., http://192.168.1.1 

2. In the top navigation bar, click Advanced. 

 

3. Configure the port forwarding table. 

 

4. Save the settings. The router should now be configured to forward any inbound requests to the 
correct SLA hardware. 
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13.2 Connect Video Client 

To connect the video client, you will need the public IP address of your router. In the example below, 
the publicly accessible IP address for this router is 140.211.16.67 (Figure 4). Optionally, use Google to 
find the public IP address of your router as shown in Figure 5. 

 

Figure 3: Router IP Internet Address Figure 4: Google IP Address Search 

For this example, the above IP address is used for the URL in the video client. 

1. Open VLC media player from your remote location. 

2. From the menu bar, go to Media » Open Network Stream (CTRL+N). 

3. Enter the network URL for your location: rtsp://140.211.16.67 

 

4. If the inbound port is changed, the port number can be added in the URL to be more specific. 

 

5. Once the above steps are complete, video should stream in the VLC media player. 
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14 Troubleshooting Streaming Issues 

Connect to the target board again using Panel Plus and check network settings and compression 

protocols are correctly configured. 

Check whether RTP port number (e.g., 5004) configured in Panel Plus or VLC media player is being used 

by any other process or service in the system. If it is being used, stop the service, and try again. 

Example:  The Windows media network sharing service on Windows 10 seems to use port 5004 and 
blocks VLC Media Player from getting the video stream. 

✓ Use the Windows command line tool netstat to see all the ports. 

✓ Check whether RTP port configured for the stream is an even number. RTP streaming will not work 
with an odd port number on some media players. 

✓ Check whether client is configured to stream RTP over TCP. 

✓ Verify the IP address, subnet mask, and Gateway are configured correctly for the network. Subnet 
m-s-match and missing or incorrect Gateway IP addresses are a common problem. 

14.1   Questions and Additional Support 

For additional issues and support, please contact Technical Support. Additional support, 
documentation and Engineering Application Notes (EANs) can be found on the Support pages of the 
SightLine Applications website.  

 

 

https://en.wikipedia.org/wiki/Netstat
mailto:support@sightlineapplications.com
http://sightlineapplications.com/support/documentation/

